
DataAssist - Getting Started Guide 
DataAssist creates all the pages you need to display, search and manage 
your online database. With DataAssist, you can create Web pages intended 
for administrative use or those to be viewed by the public with database-
driven content. 

Creating new DataAssist pages is an easy process that combines power with 
flexibility. You'll need a couple of items to start:  

• A standard dynamic Dreamweaver site in ASP, ColdFusion or PHP. If 
you have SiteAssist, create a new dynamic site using that software. 

• A connection to a data source like an Access or MySQL database. If 
you want to follow the tutorial steps exactly, create a connection 
named connBlueSkyMusic to the Blue Sky Music datasource 
included as a download from your WebAssist Download Center for 
DataAssist. 

• Optionally, a template with an editable region to hold the generated 
forms and other content.  
 
Note: If you’re using a SiteAssist site, the SiteAssist-created template 
will work well; if you’re using a CSS Sculptor created page, be sure to 
save your page as a template first with an editable region in the main 
content area.  

The DataAssist wizard guides you through the entire procedure. The key 
steps are:  

• Starting the DataAssist wizard 

• Specifying site-wide details 

• Choosing the overall design 

• Setting the Results page options 

• Defining the Results page layout  

• Choosing the Search page options 

• Defining the Detail page options 

• Selecting the Update page options 

• Setting the Insert page options 

• Testing your pages 
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Starting the DataAssist wizard 
Once you've set-up your dynamic Dreamweaver site and established a 
datasource connection, you're ready to begin the DataAssist wizard.  

1. Open a file previously saved in the site. 
 
If you're working in a new site, create a new dynamic page and save 
it. 

2. From the Files panel, make sure you're in the Dreamweaver-defined 
site you want to contain the DataAssist pages. 

3. Choose Insert > WebAssist > DataAssist > DataAssist Wizard. 
 

 
 
You can also select DataAssist Wizard from the WebAssist category of 
the Insert bar. 

The initial page of the DataAssist wizard will appear.  
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Specifying site-wide details 
The first step in the DataAssist wizard asks that you specify the database 
table you want to work with and the pages you want to build. You also have 
an option to select a template and editable region to hold the form elements 
and other generated content. 

1. From the Connection list, select the data source connection you want, 
like connBlueSkyMusic. 

2. From the Table list, choose the database table you want to manage, 
like Items (items in PHP). 

3. Make sure the Key column list has selected the table's primary key, 
like ItemID; if not, select it from the list. 

4. If you're working in a ColdFusion site and need to supply the User 
name and Password, enter that information in the appropriate fields. 

5. If desired, select a template to use from the Name list in the 
Template area, like siteassist_template. 

6. If you've chosen a template, select the area to store the generated 
content from the Editable region list, like PageBody. 

7. In the Pages area, choose which files you want created. For this 
tutorial, clear the checkbox next to Delete. 
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You'll take advantage of a DataAssist feature that adds a delete 
function to the detail page, so the Delete page is not needed. 

8. When you're done, click Next. 
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Choosing the overall design 
In the next step of the wizard, you'll select the options that provide the look 
and feel for your data management pages. In addition to selecting an overall 
design, CSS text styling and color scheme, you'll also determine the type of 
navigation to use. The preview areas update with each change you apply.  

1. From the Design list, choose the overall style you'd like for your 
pages, like Modular. 

2. From the Text list, choose the font family to use, like Verdana, 
Arial, Helvetica, sans-serif. 

3. From the Color list, select the color scheme that best matches your 
site, like Pacifica. 
 
Now you're ready to set the navigation options. The first option sets 
the look of the recordset navigation and controls found on the Results 
page. 

4. In the Navigation area, select the style of navigation from the Results 
Page list, like Icons. 

5. From the Links list, choose the style to use, like Image. 

6. From the Submit list, choose an entry to represent the Submit 
button, like Image. 
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7. Click on the Results preview to view the results page design in a 
browser and the Form page preview to see a sample Insert form. 

8. Click Next when you're done. 
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Defining the Results page layout 
DataAssist creates database-driven displays for both public and 
administrative sites. In step 3 of the wizard, you choose the type of layout 
you’d like to use for your results page. You can also set the amount of data 
to display through the Recordset paging options. 

9. From the Page type list, choose whether you’d like to use a layout 
intended for Public or Administrative display. For this tutorial, I’ll 
choose Administrative. 

10. From the Title list, choose the content you want to appear above the 
results listing. To provide the site visitor with some added detail, let’s 
choose Description. 
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11. If desired, you can add a single or dual item header between the title 
content and results table from the Header list. Here, I’ll leave the 
default option, None. 

12. Set the number of data rows and, if available, columns to display in 
the Recordset paging area. Let’s choose 10 from the Rows list. 

The Columns list becomes available if a Public Page type is selected. 
Enter the number of desired columns for your data in the Columns 
field. 

13. Leave the No results message field at its default setting.  

14. When you’re done, click Next. 
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Setting the Results page options 
On the next step of the wizard, you'll determine which fields will be displayed 
on the results page and their accompanying labels. You'll also have an 
opportunity to designate certain fields as links to the detail page.  

1. Select ItemID and click Delete. 

For this results page, you want to display just the item name, short 
description and price. You could remove each of the other fields one 
at a time, but DataAssist supports a faster method.  

2. Press Ctrl+click (on Windows) or Command+click (on Mac) to 
select the remaining unwanted data fields: ItemCatID, 
ItemLongDesc, ItemSKU, ItemThumb, ItemImage and 
ItemWeight. When you’re done, click Delete. 
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3. Select ItemName and, in the Label field, change ItemName: to 
Name:. 

4. Select ItemShortDesc and, in the Label field, change 
ItemShortDesc: to Description:. 

5. Select ItemPrice and, in the Label field, change ItemPrice: to 
Price:. 
 
The next step is to set the field(s) you'd like to use to link to the 
detail page. Here we'll set both remaining fields as links. 

6. Select ItemName and check the Link to detail page option. 

7. In the Sort fileds, select ItemName and Ascending:  

8. Click Next to continue. 
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Choosing the Search page options 
The next step of the wizard sets up the Search page. Here, you can 
determine which fields will be included in the search, how they should be 
displayed and how searched. You also have an option to include a similar 
search form on the results page to allow continued searching.  

1. Press Ctrl+click (on Windows) or Command+click (on Mac) to 
select the unwanted data fields (everything except ItemName and 
ItemCatID): ItemID, ItemPrice, ItemShortDesc, ItemLongDesc, 
ItemSKU, ItemThumb, ItemImage and ItemWeight. When 
you’re done, click Delete. 

This simple search requires only the ItemName field. You'll notice 
that you don’t need to change the label for a field previously altered; 
the DataAssist wizard automatically carries over any previously 
defined label—such as Name—to lessen repetitive data entry. 

2. Select ItemCatID and click the Down arrow to move it below 
ItemName; then, in the Label field, change ItemCatID: to 
Category:. 
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You can re-order how the search fields appear by using the Up and 
Down arrows. 

3. Leave the Display As and Criteria at their default settings for 
ItemName. 

The Name search criteria should be displayed as a text field so that 
users can enter any search words. 

DataAssist also allows you to include menu-based search criteria. 

4. Select ItemCatID and, from the Display As list, choose Menu; 
leave Criteria at its default setting. 

5. Click the Display As list lightning bolt icon. 

With the Menu option is selected, you have the option of populating 
the menu list dynamically from within the DataAssist wizard. 
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Note: To populate the menu with static items, select the menu form 
element and, from the Property inspector, choose List Values. 

6. When the DataAssist Dynamic Menu dialog box appears, click the 
Include static option at top of list option and enter Choose a 
category in the Label field. 

Text in the Label field appears as the first item in the menu with a 
null value and can be used to provide instructions to the user. 

7. From the Table list, choose the table to populate the list. Here, 
choose ItemCategory(in PHP, itemcategory). 

8. Set the Values list entry to the primary key for the data table. For 
this example, choose ItemCatID. 

For the Blue Sky Music store example, there are two categories: CD 
and Gear. 

9. From the Labels list, choose the data field with the entries you want 
displayed in the list; here, choose ItemCatName. 

10. From the Sort list, select the data field you want to order the list by 
such as ItemCatName and set the order to either Ascending or 
Descending. 
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11. Click OK when you’re done to close the DataAssist Dynamic Menu 
dialog. 

12. Leave the Include search form on results page option unchecked 

13. When you’re ready, click Next. 
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Determine the Detail page layout 
On this page of the wizard, you’re given an opportunity to control the look-
and-feel of the Detail page. 

1. From the Page type list, choose the style of layout. For this tutorial, 
I’ll choose Standard. 

2. From the Title list, choose the content you want to appear above the 
results listing. Let’s choose Page title. 

3. If desired, you can add a single or dual item header above the title 
content and results table from the Header list. Here, I’ll choose 
Single item highlight to display the image and long description. 

 

4. When you’re done, click Next. 
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Defining the Detail page options 
For this page of the wizard, you'll define which fields are to be displayed on 
the detail page; you'll also have an option to include a delete button to 
remove records.  

1. Select ItemID and click Delete. 

2. Set the necessary item labels. 

For this example, let’s change the following column labels: 

• Change ItemShortDesc to Short Description 

• Change ItemLongDesc to Long Description 

• Change ItemSKU to SKU 

• Change ItemThumb to Thumbnail 

• Change ItemImage to Large Image 

• Change ItemWeight to Weight 
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3. Select the Include delete button option. 
 

 

4. Click Next to continue. 
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Selecting the Update page options 
The Update page fields are next to be selected. Typically, the detail page and 
update pages display the same fields; because DataAssist remembers your 
labels this step is very quick.  

1. Select ItemID and click Delete. 
 

 

2. Click Next to continue. 

Note that DataAssist even remembers that the ItemCatID field can be 
represented as a menu. 
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Setting the Insert page options 
The final step in the wizard for our tutorial is to set the Insert page options. 
This page follows the same pattern as the completed Update page and is 
even easier to complete.  

1. Click Finish to complete the wizard. 

DataAssist remembes that the ItemID field was removed for the 
Update page and removes it here as well. 

 

DataAssist proceeds to create the requested pages, inserting all the desired 
forms and appropriate server-side code. When finished, all pages will be 
opened and available for customization and testing.  
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Customizing your pages 
DataAssist has done the heavy lifting in creating your online database 
management application and now you’re ready to personalize them with just 
a few clicks of the mouse.  

Although you’re free to modify any page generated, in our example, you’ll 
want to pay special attention to the Detail page. The Detail page, as you’ll 
recall, has a special single image highlight header. To properly make use of 
this page, you’ll need to bind data from the already created recordset to a 
few of the header elements. Once completed, your Detail page will display 
your record information format that’s quite easy to read. 

1. Select the detail page generated by the DataAssist wizard; in our 
example, it’s items_Detail.php.  

First, let’s expose the dynamic data in the recordset to be inserted 
into the page or bound to particular tags. 

2. Choose Window > Bindings to open the Bindings panel. 

3. Expand the recordset entry. In this example, its Recordset 
(WADAitems). 

Next, let’s replace the generic Page Title text with the product name. 

4. Select the placeholder text Page Title and press Delete. 

5. From the Bindings panel, choose the primary name field which, here, 
is ItemName, and click Insert at the bottom of the Bindings panel. 

6. Select the placeholder text Item Name and press Delete. Repeat 
step 5. 

7. Select the placeholder descriptive paragraph and press Delete.  From 
the Bindings panel, select ItemLongDesc and click Insert. 

8. Repeat the process to replace the placeholder price 49.95 with the 
dynamic entry ItemPrice. 

9. Place your cursor in the placeholder text [button] in the same line 
as the price and, from the Tag Selector, choose <div # 
WADAPageHeaderButtonPrice>. Press Delete to remove it. 
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The final dynamic element to add is the image. 

10. Select the placeholder image and, from the Bindings panel, choose 
ItemImage. Click Bind from the bottom of the Bindings panel. 

Note: The image will appear with a placeholder symbol at the default 
size (32 x 32). When populated with dynamic data, the image will be 
displayed at it’s proper size. 

In our example, the database stores just the filename of the 
graphic—which means that the path needs to be specified for the 
image. 

11. With the dynamic image selected, prepend the relative path to the 
Src value in the Property inspector. For our example, you would 
add images/detail/. 

There’s one final adjustment to make: remove the static height value 
to allow the header area to expand dynamically. 

12. From the Tag Selector, choose <div #WADAPageHeaderArea>. 
Select Window > CSS Styles and switch to Current mode. In the 

 Page 21 



DataAssist
   

Properties pane, select the Height entry and click the the 
trashcan icon to remove it. 

Note: Dreamweaver 8 users can right-click on the entry and choose 
Delete from the shortcut menu. 

 

You’re all ready to move to the next stage of development: testing. 
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Testing your pages 
After the pages have been generated and customized, you'll want to try them 
out. All the pages are interconnected, so you can begin your testing by 
selecting the Search page.  

Coldfusion users: Please note that the Coldfusion pages created 
by the wizard require session management variables to be set for 
your website. If you are not configured appropriately for session 
management, your pages may return a ColdFusion runtime error: 
"Cannot lock session scope".  
 
ColdFusion sites that use DataAssist have the following two 
requirements:  

• a file named Application.cfm must be included at the root of 
your site and contain the following code: 
 
<cfapplication name="YourSiteName" 

sessionmanagement="Yes"> 

Your ColdFusion Server must have session variables enabled. Log in 
to your ColdFusion Server Administrator and under Server Settings, 
click the Memory Variables link to navigate to that configuration 
section. Make sure that Enable Session Variables is checked, and 
click the Submit Changes button to update your settings. If you do 
not administrate your server or have it hosted elsewhere, please 
contact your hosting provider to confirm these settings. 



DataAssist
   

1. Locate the tab for the Items_Search page for your server model. 
 

 

2. Press F12 (Option+F12 on the Macintosh) to preview the page in your 
browser. 

3. When the page opens in your browser, click Search—without entering 
any search criteria—to view all the Items. 
 
The Items_Results page is displayed, complete the recordset 
navigation and controls in place. 
 
Note: If you'd like to test the search function, select one of the two 
items from the Category list—CD or Gear—and press Search. 
Alternatively, enter cap into the Name field and click Search. 

4. In the recordset navigation controls, click Next to view the next set 
of records. 
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You'll note that the recordset navigation controls automatically 
display controls as needed; for example, Previous and First controls 
are now displayed. 

5. To see a detailed record, select the associated View icon; for 
example, click the View icon next to the Body Double record. 
 

 

6. Click Update to display the Items_Update page for the current 
record. 

7. On the Items_Update page, change the price from 19.99 to 14.99 
and click Update to confirm your modification. 
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You're returned to the detail page where the update can be seen. 

8. From the Items_Detail page, click Cancel. 

You can also add new records. 

9. From the Items_Results page, click Insert. 

10. When the Items_Insert opens, enter the following new record 
information: 
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• From the Category list, choose Gear 

• In the Name field, enter Laptop Case 

• In the Short Description field, enter The sleekest way to 
protect your laptop 

• In the Long Description field, enter Don't let anything happen 
to your most precious gear. Travel safely and stylishly with 
the Blue Sky Music laptop case. 

• In the SKU field, enter BSM_12 

• Leave both the Thumbnail and Large Image fields blank 

• In the Weight field, enter 1.0 

11. When your finished, click Insert. 
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The newly added record is displayed on the detail page. Let's now try 
removing a record. 

12. From the Items_Detail page, click Delete. 
 
The results page is displayed; to confirm that the inserted record has 
been deleted, let's search for the record. 

13. In the Search form's Name field, enter laptop and click Search. 

14. The Items_Result page is shown, with your custom no results 
message. 
 
Feel free to continue exploring your new administrative front-end. 
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